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Abstract: The reliability of power distribution systems is a crucial factor in ensuring stable electricity 

supply for industrial, commercial, and household users. Conventional protection systems often face 

limitations in terms of real-time monitoring, remote control, and adaptive responses to fault conditions, 

which can result in longer outage durations and higher operational costs. This research aims to develop 

a smart protection system for power distribution using Internet of Things (IoT) technology to enhance 

system reliability. The proposed method integrates IoT-enabled sensors, microcontrollers, and 

communication modules to monitor critical parameters such as voltage, current, and frequency in real 

time. Data are transmitted to a cloud-based platform for analysis and decision-making, enabling rapid 

detection of abnormalities and remote tripping of circuit breakers. The prototype was tested under 

various fault scenarios, including short circuits and overloads, and demonstrated faster response times 

compared to conventional systems. Results show that the IoT-based protection system improved fault 

detection accuracy, reduced downtime, and provided predictive maintenance insights through data 

analytics. The synthesis of these findings highlights that integrating IoT into protection mechanisms 

not only increases operational reliability but also supports the transition toward smart grids. In 

conclusion, the developed system proves effective in addressing the limitations of traditional protection 

systems by offering real-time monitoring, automation, and enhanced decision-making for modern 

power distribution networks. 
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1. Introduction 
The reliability of electrical power distribution systems plays a fundamental role in 

sustaining industrial, commercial, and residential activities (Rajaa et al. 2024; Tan et al. 2024; 
Yingying et al. 2022). With the growing demand for electricity and the increasing complexity 
of power networks, the occurrence of disturbances such as short circuits, overloads, and 
voltage fluctuations has become more frequent and difficult to manage (Artono et al. 2025; 
Prasetyo et al. 2023). Conventional protection systems, while widely applied, often rely on 
fixed settings and limited communication capabilities, which reduce their effectiveness in 
addressing dynamic grid conditions. These limitations may lead to longer outage durations, 
higher maintenance costs, and lower customer satisfaction. 

In recent years, the integration of digital technologies into power systems has accelerated 
the development of smart grids. One of the key enablers of this transformation is the Internet 
of Things (IoT), which provides real-time sensing, monitoring, and communication 
capabilities (Abhin et al. 2024; Hosseinian et al. 2020; Nuruzzaman and Rana 2025). IoT-
based systems allow distributed devices to collect and transmit operational data, enabling 
more accurate fault detection and faster response mechanisms. Compared to conventional 
approaches, IoT offers scalability, flexibility, and interoperability that are essential for modern 
power distribution networks (Mnyanghwalo and Kawambwa 2024; Murianto, Febrianto, and 
Azmi 2020; Zhang 2016). 
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Although several studies have explored the application of IoT in smart grid monitoring, 
most existing works focus on general system supervision rather than the specific domain of 
distribution protection (Balasubramanian and Lal Raja Singh 2023; Pradeep et al. 2023; Singh 
and Paliwal 2022). Furthermore, many approaches emphasize data acquisition but lack 
integration with automated control and decision-making mechanisms. This creates a gap in 
developing comprehensive IoT-based protection systems that combine real-time monitoring, 
rapid fault isolation, and predictive maintenance (Prasetyo et al. 2025). 

This research addresses the gap by proposing and implementing a smart protection 
system in power distribution using IoT technology. The main contribution lies in designing a 
prototype that integrates IoT-enabled sensors, microcontrollers, and cloud-based platforms 
to achieve real-time fault detection and automated protective actions. By validating the system 
under different fault scenarios, this study demonstrates improved fault detection accuracy, 
reduced outage duration, and enhanced decision-making compared to traditional protection 
systems. Ultimately, the findings contribute to the advancement of intelligent and resilient 
distribution networks, supporting the broader vision of smart grid development. 

 
2. Research Method 

This study employs an experimental research approach combined with system 
prototyping to develop and evaluate an IoT-based smart protection system for power 
distribution. The methodology consists of four main stages: system design, hardware 
development, software integration, and performance testing (Sintia Ningrum and Pandji 
Triadyaksa 2020). 

 
Figure 1. Research Method Flowchart. 

 

System Design 
The system architecture was designed to integrate IoT-enabled devices with protective 

equipment in the distribution network. The design includes three core layers: (a) the sensing 
layer, which measures electrical parameters such as current, voltage, and frequency; (b) the 
communication layer, which transmits data using wireless modules; and (c) the application 
layer, which processes data in a cloud platform and provides control commands. 
 
Hardware Development 

The prototype was built using microcontrollers (ESP32) as the central processing unit, 
current and voltage sensors for parameter acquisition, and relays to simulate circuit breaker 
operation. All components were assembled and connected to simulate a small-scale 
distribution feeder. 
Software Integration 

The system was programmed using embedded C and Python for microcontroller 
operation and data processing. A cloud-based platform (e.g., Blynk/ThingSpeak) was utilized 
to collect, analyze, and visualize real-time data. Fault detection algorithms were implemented 
to identify abnormal conditions, while automated tripping commands were integrated to 
isolate faults. 
Performance Testing 

The prototype was tested under different fault scenarios, including overload, short circuit, 
and normal operating conditions. Key performance indicators (KPIs) evaluated were 
response time, fault detection accuracy, and system reliability compared to conventional 
protection systems. Data were collected, analyzed statistically, and synthesized to assess the 
effectiveness of the proposed system. 
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3. Proposed Method 
The figure 2 is illustrates the prototype design of an IoT-based smart protection system 

for a three-phase power distribution network, where the incoming supply lines (R, S, T, and 
G) are connected to sensors and protective components for real-time monitoring. Current 
and voltage sensors measure electrical parameters, while relay modules act as protective 
switches that disconnect faulty lines when abnormalities occur. Manual control is provided 
through red and green push buttons, allowing operators to reset or disconnect the system 
when needed. The Arduino microcontroller functions as the central processing unit, 
executing protection algorithms and coordinating with the IoT module (ESP8266/ESP32), 
which transmits data wirelessly to a cloud platform for remote monitoring, visualization, and 
control. A breadboard and wiring are used for prototyping and circuit integration. On the 
output side, the protected three-phase lines continue toward the load after passing through 
the system. Overall, the design demonstrates how sensors, microcontrollers, relays, and IoT 
connectivity are integrated to enable automatic fault detection, rapid fault isolation, and 
remote supervision, thereby enhancing the reliability and intelligence of power distribution 
networks. 

 

 
Figure 2. Research Method Flowchart. 

 
4. Results and Discussion 

The proposed IoT-based smart protection system was developed and tested using a 
laboratory-scale prototype of a three-phase distribution feeder. The system’s performance 
was analyzed under three operating conditions: normal operation, overload, and short-circuit 
faults. Key indicators such as fault detection accuracy, system response time, and real-time 
monitoring capability were compared against conventional protection systems. 
Arduino Mega 2560 Testing 

This design uses an Arduino Mega 2560, which functions as the system controller and 
the brain of the system, as well as reading the voltage divider and ACS712 current sensors. 
Testing the Arduino Mega 2560 board aims to determine whether the program uploaded to 
the Arduino Mega 2560 is functioning properly. Here are the steps for testing the Arduino 
Mega 2560 board: a). Create a program (coding) in the Arduino IDE software, b). Connect 
the Arduino Mega to a laptop's USB port using a mini-USB connector cable, c). Once 
connected, select the "Tools" menu and then select the Arduino Mega 2560 board. Then 
select the detected port, d). Compiling the program is necessary to ensure that the program 
is syntactically and algorithmically correct. After compiling, a "done compiling" notification 
will appear, as shown in Figure 3. 
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Figure 3. The program is successfully compiled. 

 

e). Upload the compiled program to the Arduino Mega board. When the "Done 
uploading" notification appears, the program has been successfully uploaded to the 
Arduino board. The "Done uploading" notification can be seen in Figure 4. 

 
Figure 4. The program is successfully uploading. 

 

Testing the NodeMCU ESP8266 Wi-Fi Module 
This study used the NodeMCU ESP8266 Wi-Fi Module to determine whether the Wi-

Fi module can connect or communicate with Wi-Fi and Android applications, and to 
determine the level of internet stability in the monitoring system. 

Here are the steps for testing the NodeMCU ESP8266 Wi-Fi Module: 
1. Open the Arduino IDE software. 
2. Open the File menu - Preferences, in the Additional Manager section, enter the URL: 
http://arduino.esp8266.com/stable/package_esp8266com_index.json. Then press the 
OK button. Open the Tools menu - Board - Board Manager, then search for ESP8266 
and click the Install button. The menu for entering the URL can be seen in Figure 5. 
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Figure 5. Copy URL for ESP8266 Library. 

 

3. If the installation is successful, the "NodeMCU 1.0 (ESP-12E Module)" option will 
appear in the "Tools - Board" menu. Select the "NodeMCU 1.0 (ESP-12E Module)" 
board, compile it, and upload the program to the Arduino connected to the NodeMCU 
ESP-12E Wi-Fi module. The NodeMCU board and port selection can be seen in Figure 
6. 

 
Figure 6. The NodeMCU board and port selection. 

 

4. After uploading, the sensor values are successfully sent from the Arduino Mega 2560 
via serial communication and a Wi-Fi module. The NodeMCU ESP8266 can be used to 
transfer data to the Arduino Mega 2560. Blynk server. The NodeMCU ESP8266 Wi-Fi 
module test circuit can be seen in Figure 7. 
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Figure 7. The NodeMCU ESP8266 Wi-Fi module test. 

 

Testing the Voltage Divider 
The purpose of testing the voltage divider is to determine whether the voltage sensor is 

functioning properly to measure the voltage in the system. Here are the steps for testing the 
voltage divider: 

 Ensure the Arduino Mega 2560 and NodeMCU ESP8266 programs have been 
uploaded to the Arduino IDE and there are no upload errors. 

  Connect the three voltage divider outputs to ports A0, A1, and A2 on the Arduino 
Mega 2560. 

 Connect the GND terminals of the voltage sensors to the GND terminal on the 
Arduino Mega 2560. 

 Connect the RX terminal of the Arduino Mega 2560 to the RX terminal of the 
NodeMCU ESP8266, and the TX terminal of the Arduino Mega 2560 to the TX 
terminal of the NodeMCU ESP8266. 

 Connect the voltage sensor inputs in parallel to each of the R, S, and T phase sources. 
 Power the Arduino Mega 2560 and NodeMCU ESP8266 using a 5V adapter. 
 Observe and record the measurements on the Android screen using the Blynk app. 
 

Table 1. Testing the Voltage Divider. 

No Result 

Voltage testing on  
phase R 
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No Result 

Voltage testing on  
phase S 

 

 

Voltage testing on  
phase T 

 

 

 
This study has demonstrated that the monitoring system was able to capture and display 

real-time voltage and current data with high accuracy. The main findings show that the voltage 
on phase R was consistently maintained around 20.920 kV, while the current fluctuated 
slightly at around 0.430 A. The main findings show that the voltage on phase S was 
consistently maintained around 24.050 kV, while the current fluctuated slightly at around 
0.310 A. The main findings show that the voltage on phase T was consistently maintained 
around 19.750 kV, while the current fluctuated slightly at around 0.490 A. These results 
indicate that the system is reliable for continuous observation and analysis of electrical 
parameters in table 1. 

The findings strongly support the initial research objective, which aimed to design a 
monitoring tool capable of providing accurate and live measurements. The integration of 
graphical visualization and digital dashboards further enhances the usability of the system, 
making it suitable for practical applications in the field. This synthesis of results emphasizes 
the effectiveness of the developed approach in ensuring both stability and efficiency of 
monitoring. 

 
6. Conclusions 

In terms of contribution, this research provides valuable insight into the development 
of digital-based electrical monitoring systems. The implementation can potentially improve 
operational decision-making, reduce downtime due to power disturbances, and serve as a 
reference for the design of future monitoring technologies. This strengthens the body of 
knowledge in the field of smart electrical system management. 

However, this study has limitations, particularly in terms of measurement coverage and 
scalability. The monitoring was limited to a single phase and a relatively short observation 
period. Future research is recommended to extend the system into a three-phase monitoring 
application, integrate predictive analysis using artificial intelligence, and conduct long-term 
performance testing. This would enhance the generalizability, robustness, and practical 
benefits of the system for industrial applications. 
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